
Photoshop workspace

Open Photoshop
Download lesson2.zip (2.7MB) and UnZip the files onto your computer.

Open Photoshop while pressing [Command+Option+Shift] (Mac) or [Control+Alt+Shift] (PC). 

This will delete the Photoshop settings file, so your screen will match the tutorial. 

To start with an empty screen.

1.  Click File on the menu bar, then click New 

2.  Type a number in the Width text box, choose pixels in the width pop-up menu 

3.  Type a number in the Height text box, choose pixels in the height pop-up menu 

4.  You will see an empty window. 

Examine the Photoshop workspace 

http://fgamedia.org/faculty/cbrown/studio1/02_layers/lesson2.zip


Photoshop workspace

title bar displays the file name of the open file 

menu bar 
contains Photoshop commands, some commands have keyboard shortcuts on the right side 
of the menu, commands that are gray are not available 

toolbox
contains tools associated with frequently used commands, the icon of the tool shows its 
function. A small black triangle in the lower-right corner indicates additional tools. 

options bar displays the current settings for the selected tool 

palettes
small windows stacked on the right side of the workspace these are used to change settings 
and modify images. Palettes can be separated and moved by dragging their tabs. 

status bar located at the bottom of the workspace. Displays file size and description of selected tool. 

To open an existing image.

1.  Click File on the menu bar, then choose Open 
2.  Locate the file  sky.psd  and click Open 
3.  You will see the image in the window. 

You can get existing images by scanning flat 
artwork, scanning film, photographing with a 
digital camera, saving from a web site, saving 
from a video, copying from a CDROM, or 
anywhere else that digital imagery is available. 



Layers and History

Layers, the History palette, and zoom 
Layers 

A layer is a selection within an image that can be manipulated independently. 

You can think of layers in Photoshop as pieces of clear plastic that are in a stack. 

Each Photoshop file has at least one layer, and can contain many individual 

layers. The Layers palette shows all the layers in a file. There are different types 

of layers: for artwork, type, fill, and adjustment. You can use the Layers palette to 

create, copy, delete, hide, merge, lock, group, or reposition layers. 

The order in which layers appear in the Layers palette matches the order in which they appear in the image. The topmost 

layer in the palette is the topmost layer on the image. You make a layer active by clicking on its name in the Layers 

palette. The active layer is highlighted.

You can use the Layers palette to control which layers are visible in an image. You can show or hide a layer by clicking 

the Indicates layer visibility (eyeball) button to the left of the layer thumbnail.

1.  Click the Balloon 1 layer on the Layers palette. 

2.  Click the Indicates layer visibility box on the Balloon 1 layer to see the image on that layer. 

3.  Click the Indicates layer visibility box on the Balloon 2 and Balloon 3 layers to see the other images. 

4.  In the Layers palette click the Indicates layer visibility box on the clouds layer to turn off that layer. The 

background now looks like a gray check pattern, you will see the gray check pattern whenever an image is 

transparent. 

5.  Click the Balloon 2 layer on the Layers palette, and drag the layer above the Balloon 3 layer. Balloon 2 will be in 

front of Balloon 3 in the Photoshop window. 

6.  Click the Balloon 3 layer in the Layers palette and click the delete layer  button at the bottom of the Layers 
palette. Balloon 3 is deleted from the Layer palette and the Photoshop window. 

Using the History palette 



Photoshop records your last 20 actions 

on the History palette. The History palette 

allows you to undo you actions by 

selecting and deleting them. You can also 

create a new image from any point in the 

History palette.

In the History palette click the line that says "Delete Layer" and click the delete current state  button at the bottom of 
the History palette. Balloon 3 is restored to the Layer palette and the Photoshop window. 

Click File on the menu bar, then click Save.

Getting a closer look 

When you edit an image in Photoshop, it is important that you have a good view of the area you are working on. There 

are several ways you can enlarge or reduce your current view. Before you enlarge, select the Resize Window to Fit 

check box and the window will get bigger as you zoom in. 

 

You can use the Zoom tool  to click on the image to enlarge your view. You are not enlarging the image, you are 

only enlarging your view. You can reduce your view by holding the Alt (Win) or Option (Mac) key when you click the 

zoom tool. Double clicking the Zoom tool in the Toolbox will resize your image to the actual size.

Using the Navigation palette 

You can also change your view using the Navigation palette. At the bottom of 

the Navigation palette you can type in a magnification percentage, use the slider, 

or click the mountain buttons to enlarge or reduce. 

The red box shows you the current view in the Photoshop window. Click and drag the red box to move around in the 

image. 



Printing

Printing
You can print your Photoshop image using any desktop printer. The printed image will be a composite of all the 

visible layers. The quality of your printer and paper will affect the appearance of your image. In many cases a 

professional print shop is the best options for printing a high quality Photoshop image. 

The Page Setup dialog box displays options for printing, such as paper orientation. 

Orientation is the direction in which the image appears on the page. In Portrait orientation, 

the image is printed with the paper shorter edges of the paper at the top and bottom. In 

Landscape orientation, the image is printed with the longer edges of the paper at the top and bottom. Page 

setup settings vary slightly on Macintosh and Windows. 

1.  Click File on the Menu bar, then click Page Setup to open the Page Setup dialog box. 

2.  Click the Landscape option button in the Orientation section, then click OK 

Use the Print command when you want to print multiple 

copies of an image. Use the Print One Copy to print a 

single copy without making dialog box selections, and 

use the Print with Preview command when you want 

to use color management. Print settings vary slightly on 

Macintosh and Windows. 

1.  Click File on the Menu bar. 

2.  Make sure that the All option button is selected in the Pages section (Mac) or Print range section 

(Win), and that 1 appears in the Number of copies text box. 

3.  Click Print (Mac) or OK (Win). If a PostScript dialog box opens (Mac) click OK. 

Save and Exit



Printing

1.  Click File on the Menu bar, then click Save. 

2.  Click Photoshop on the menu bar, then click Quit Photoshop (Mac). Or click File on the Menu bar, 

then click Exit (Win). 



Add, delete, and rearrange layers

Add, delete and rearrange layers 
Examining Layers 

The Layers palette lists all the layer names in a Photoshop file and makes it possible for you to manipulate one 

or more layers. If a layer name is very long, an ellipsis (...) appears, indicating that part of the name is hidden 

from view. You can view the layer's entire name by holding the cursor over the name until the full name 

appears. The layer thumbnail appears to the left of the layer name and contains a small picture of the layer's 

content, if the layer contains text there will be a type layer icon (T) in the thumbnail. At the bottom of the Layers 

palette are buttons for manipulating layers such as the Delete layer button and the Create new layer button. 

The Layers palette includes several types of layers: Background, Type and Image. The Background layer, with 

its name in italics, is always at the bottom of the Layers list. The Background layer is locked so you cannot 

move it, and it also has limited editing capabilities. You can convert the Background layer in to a regular image 

layer by double clicking the Background layer and changing its name. Once it is converted to an image layer, 

you can use the full range of editing tools. 

One of the benefits of using layers is that you can create different compositions by rearranging the order of the 

layers. Figure 2 has the same layers as Figure 1, but they are arranged differently. Look carefully at each 

image and layer palette to see how rearranging the order of the layers changes the image in Photoshop. Do 

you see that the type is partially covered by the wreath in Figure 2? This arrangement is created by dragging 

the wreath layer above the text layer. 

Figure 1  



Add, delete, and rearrange layers

  

Figure 2  

Adding layers to an image 

Because using multiple layers is so important, Photoshop makes it easy to add and delete layers. You can add 

layers in three ways:

●     Use the New command on the Layer menu, 

●     Use the New Layer command on the Layers palette menu, 

●     Click the Create a new layer button on the Layers palette. 

New layers are automatically inserted above the active (highlighted) layer. New layers are named Layer 1, 

Layer 2, and so on. You can rename a layer by double clicking on the layer name in the Layers palette and 

typing a new name. Objects on new layers have a default opacity of 100%, which means they will cover objects 

on lower layers. 

Start Photoshop, click File on the menu bar, then choose Open. Locate the file  new_england.psd  and click 

Open. You can also double-click on the file new_england.psd to open it. 



Add, delete, and rearrange layers

Add a layer using the Layer menu

1.  Click the New England layer on the Layers 
palette 

2.  Click Layer on the menu bar, point to New, 
then click Layer to open the New Layer 
dialog box. 

3.  Click OK and Layer 1 will be added to your 
image. 

  

Add a layer using the Layers palette

1.  Click the New England layer in the Layers 
palette 

2.  Click the Create a new layer button at the 
bottom of the Layers palette 

3.  Layer 2 will be added to your image. 

Delete a layer 

1.  Click on Layer 2 in the Layers palette, hold the Shift key on your keyboard and click on Layer 1 in the 

Layers palette to select both layers. 

2.  Click on the Delete layer button  at the bottom of the Layers palette. 
3.  If the Delete the selected layers? dialog box opens, click the Don't show again check box, then click 

Yes. 



Move a selection

Move a selection from one image to another 
Understanding selections 

While working in Photoshop, you will often want to combine images. To use an image or part of an image, you 

must first make a selection. A selection is an area of an image surrounded by a marquee, a dashed line that 

surrounds the area you want to use. You can drag a rectangular or oval marquee using the marquee tools. But 

if the area you want to select is not rectangular or oval, then you will need to use another method.

●     Use the Quick Selection Tool to "paint" your selection or use the Magic Wand Tool  to select 

areas of similar color. 

●     The Magnetic Lasso Tool  selects complex shapes by clicking the starting point, tracing an 

approximate outline, then clicking the ending point. 

●     Exclude certain parts of an image with the Crop Tool . To use the Crop Tool, drag a box around 

the area you want to keep, then press Enter (Win) or Return (Mac). 

●     The Extract command, in the Filter menu, separates an image from a background or surrounding 

imagery. 

●     The Color Range command, in the Select menu, selects a particular color contained in an existing 

image. Depending on the area you want you can use the Color Range dialog box to extract a portion of 

an image. 

Use the Move Tool  to drag the selection from the original image to a new image. Photoshop places the 

selection in a new layer above the active layer. When you move a selection to a new image it may contain 

unwanted pixels that give the appearance of a rough edge. You can remove these pixels using a matting 

command called Defringe. This command is in the Layers menu and allows you to replace the unwanted 

pixels with colors from other nearby pixels. 



Move a selection

Make a color range selection 

1.  Click File on the menu bar, then choose Open. 
2.  Locate the file  gourds.psd  and click Open. 
3.  Drag the window to an empty area on your screen so 

you can see both images. 
4.  Click Select on the menu bar then click Color Range. 
5.  Select the Image button, then type 0 in the Fuzziness 

box. 

6.  Select the Eyedropper  in the toolbox and click it 
on the white background of the image in the Color 
Range dialog box. 

7.  Select the Invert Check box. 
8.  Click OK, the marquee will surround the gourds as 

shown. 

 

  

Move a selection to another image

1.  Click the Move Tool  in the toolbox. 
2.  Position the Move Tool anywhere over the selection 

in the gourds image. 
3.  Click and hold the mouse button and drag the 

selection to the New England image. 
4.  Release the mouse. 
5.  The gourds selection moves to the New England 

image appearing on Layer 1. 
6.  If necessary, use the Move Tool to drag the gourds to 

the location at the lower left corner of the wreath. 



Move a selection

Defringe the selection

1.  Click Layer on the menu bar, point to 
Matting, then choose Defringe. Defringing 
a selection gets rid of the edge that 
sometimes occurs when objects are 
dragged from one image to another. 

2.  Type 2 in the Width text box, then click OK. 
3.  Save your work. 

 Before Defringe After Defringe 



Rename and flatten layers

Rename layers and flatten layers 
Rename and adjust opacity of a layer 

Adding the gourds to the New England image created a new layer named Layer 1. All new layers are named 

"Layer" followed by a number. It is much more useful to name layers something meaningful.

●     Double-click Layer 1, type Gourds, then press return (Mac) or Enter (Win).  

Even after defringing, the gourds may not blend into the New England image as well as you might like. 

Adjusting the opacity of a layer blends the that layer with the layers below.

●     Double-click the Opacity text box on the Layers palette, type 75, then press return (Mac) or Enter 

(Win). Drag the gourds layer under the wreath layer to place it behind the wreath in the image. 

Flattening layers

After you make all the necessary 

modifications to your image, you can greatly 

reduce the file size by flattening the image. 

Flattening merges all visible layers and 

discards all hidden layers. Make sure that 

all layers that you want to display are visible 

before you flatten the image. Because 

flattening removes al image's individual 

layers, it is a good idea to make a copy of 

the original image before it is flattened. The 

status bar displays the current file size and 

the size it will be when it is flattened. 

1.  Click File on the menu bar, then 

choose Save As. 

2.  Select the As a Copy check box. 



Rename and flatten layers

3.  Click Save. Photoshop saves and 

closes a copy of the file containing all the layers. Click OK in the Format Options box if necessary. 

4.  Click Layer on the menu bar, then choose Flatten image. 

5.  Save your file. 

6.  Exit or Quit Photoshop. 

Complete your Creative Exercise 

http://fgamedia.org/faculty/cbrown/studio1/02_layers/exercise2.pdf
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